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Introduction
Tax Administration Sales allows you to calculate taxes based on the legal 
requirements for the Andean region. You can view, edit and apply the potential 
taxes or withholdings. You can view credit notes and debit notes that are generated 
for the taxes you have edited.

Tax Administration Sales also integrates with Analytical Accounting to provide you 
with detailed analysis information for credit notes and debit notes that are 
generated for the taxes you have edited in Tax Administration Sales.

Check for current instructions
This information was current as of May 2010. The documentation may be updated 
as new information becomes available. Check the Microsoft Dynamics® GP online 
Web site (http://go.microsoft.com/fwlink/?LinkID=161199) for the most current 
documentation.

The introduction is divided into the following sections:

• What’s in this manual
• Symbols and conventions
• Resources available from the Help menu
• Send us your documentation comments

What’s in this manual

This manual is designed to give you an in-depth understanding of how to use the 
features of Tax Administration Sales, and how it integrates with the Microsoft 
Dynamics GP system.

To make best use of Tax Administration Sales, you should be familiar with 
systemwide features described in the System User’s Guide, the System Setup 
Guide, and the System Administrator’s Guide.

Some features described in the documentation are optional and can be purchased 
through your Microsoft Dynamics GP partner.

To view information about the release of Microsoft Dynamics GP that you’re using 
and which modules or features you are registered to use, choose Help >> About 
Microsoft Dynamics GP.

This manual is divided into the following chapters:

• Chapter 1, “Setup,” explains how to set up Tax Administration Sales for your 
company.

• Chapter 2, “Transactions,” describes the process of calculating taxes and 
withholdings for sales transactions. You can also view, edit and apply the 
potential taxes or withholdings.

• Chapter 3, “Inquiries and reports,” explains how to view the information you 
have entered into the system and generate the reports.

http://go.microsoft.com/fwlink/?LinkID=161199
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Symbols and conventions

For definitions of unfamiliar terms, see the glossary in the manual or refer to the 
glossary in Help.

This manual uses the following conventions to refer to sections, navigation and 
other information.

Resources available from the Help menu

The Microsoft Dynamics GP Help menu gives you access to user assistance 
resources on your computer, as well as on the Web.

Contents
Opens the Help file for the active Microsoft Dynamics GP component, and displays 
the main “contents” topic. To browse a more detailed table of contents, click the 
Contents tab above the Help navigation pane. Items in the contents topic and tab 
are arranged by module. If the contents for the active component includes an 
“Additional Help files” topic, click the links to view separate Help files that 
describe additional components.

To find information in Help by using the index or full-text search, click the 
appropriate tab above the navigation pane, and type the keyword to find.

To save the link to a topic in the Help, select a topic and then select the Favorites tab. 
Click Add.

Index
Opens the Help file for the active Microsoft Dynamics GP component, with the 
Index tab active. To find information about a window that’s not currently displayed, 
type the name of the window, and click Display.

About this window
Displays overview information about the current window. To view related topics 
and descriptions of the fields, buttons, and menus for the window, choose the 
appropriate link in the topic. You also can press F1 to display Help about the current 
window.

Symbol Description

The light bulb symbol indicates helpful tips, shortcuts and 
suggestions.

The warning symbol indicates situations you should be 
especially aware of when completing tasks.

Convention Description

Creating a batch Italicized type indicates the name of a section or procedure.

File >> Print or File > 
Print

The (>>) or (>) symbol indicates a sequence of actions, such as 
selecting items from a menu or toolbar, or pressing buttons in 
a window. This example directs you to go to the File menu and 
choose Print.

TAB or ENTER All capital letters indicate a key or a key sequence.
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Lookup
Opens a lookup window, if a window that you are viewing has a lookup window. 
For example, if the Checkbook Maintenance window is open, you can choose this 
item to open the Checkbooks lookup window.

Show Required Fields
Highlights fields that are required to have entries. Required fields must contain 
information before you can save the record and close the window. You can change 
the font color and style used to highlight required fields. On the Microsoft 
Dynamics GP menu, choose User Preferences, and then choose Display.

Printable Manuals
Displays a list of manuals in Adobe Acrobat .pdf format, which you can print or 
view.

What’s New
Provides information about enhancements that were added to Microsoft Dynamics 
GP since the last major release.

Microsoft Dynamics GP Online
Opens a Web page that provides links to a variety of Web-based user assistance 
resources. Access to some items requires registration for a paid support plan.

Current implementation and upgrade information The most recent 
revisions of upgrade and implementation documentation, plus documentation 
for service packs and payroll tax updates.

User documentation and resources The most recent user guides, how-
to articles, and white papers for users.

Developer documentation and resources The most recent 
documentation and updated information for developers.

Product support information Information about the Microsoft Dynamics 
GP product support plans and options that are available, along with 
information about peer support and self-support resources.

Services information Information about Microsoft Dynamics GP support, 
training, and consulting services.

Microsoft Dynamics GP Community Access to newsgroups, where you 
can ask questions or share your expertise with other Microsoft Dynamics GP 
users.

CustomerSource home page A wide range of resources available to 
customers who are registered for a paid support plan. Includes access to 
Knowledge Base articles, software downloads, self-support, and much more.

Customer Feedback Options
Provides information about how you can join the Customer Experience 
Improvement Program to improve the quality, reliability, and performance of 
Microsoft® software and services.
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Send us your documentation comments

We welcome comments regarding the usefulness of the Microsoft Dynamics GP 
documentation. If you have specific suggestions or find any errors in this manual, 
send your comments by e-mail to the following address: bizdoc@microsoft.com.

To send comments about specific topics from within Help, click the Documentation 
Feedback link, which is located at the bottom of each Help topic.

Note: By offering any suggestions to Microsoft, you give Microsoft full permission to use 
them freely.

mailto:bizdoc@microsoft.com
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Chapter 1: Setup
Use this information to set up your system to generate the sales tax reports for your company. 
You can calculate the taxes and the withholdings (negative taxes) for sales transactions.

When you set up Tax Administration Sales, you can open each setup window and enter 
information, or you can use the Setup Checklist window (Microsoft Dynamics GP menu >> 
Tools >> Setup >> Setup Checklist) to guide you through the setup process. See your System 
Setup Guide (Help >> Contents >> select Setting up the System) for more information about 
the Setup Checklist window.

• Setting up the sales tax defaults
• Setting up the tax details

Setting up the sales tax defaults

Use the Default Tax Setup - Sales window to specify the default tax settings for sales 
transactions. This setting will default in the Receivables Tax Entry window (Transactions >> 
Sales >> Transaction Entry >> Tax expansion button). You can change this setting during 
transaction entry.

To set up the sales tax defaults:
1. Open the Default Tax Setup - Sales window.

(Microsoft Dynamics GP menu >> Tools >> Setup >> Sales >> Sales Tax Setup)

The Company ID field displays the company you are logged into.

2. Mark the Apply Tax checkbox to apply positive taxes by default to sales 
transactions.

3. Mark the Apply Withholding checkbox to apply withholding taxes by default 
to sales transactions.

4. Enter the next number to be used for credit notes that are generated when you 
cancel positive taxes or add withholding taxes.
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5. Enter the next number to be used for debit notes that are generated when you 
add positive taxes or cancel withholding taxes.

6. Choose OK to save your settings, or choose Cancel to cancel the process and 
close the window.

Setting up the tax details

Use the Tax Detail Maintenance window (Microsoft Dynamics GP menu >> Tools >> 
Setup >> Company >> Tax Details) to set up the tax detail IDs for the positive and negative 
taxes to use when entering sales transactions. Refer to the System Setup documentation for 
more information.

Be sure to mark the Enable Reverse Charge Taxes checkbox in the Company Setup Options 
window (Microsoft Dynamics GP menu >> Tools >> Setup >> Company >> Company >> 
Choose Options) to calculate the withholdings.
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Chapter 2: Transactions
Use this information to understand the process of calculating taxes and 
withholdings for a sales transaction. You can also view, edit, and apply the 
potential taxes or withholdings.

This information is divided into the following sections:

• Modifying taxes
• Viewing potential taxes for Receivables Management transactions
• Viewing potential taxes for Sales Order Processing transactions
• Using the Sales Tax wizard
• Editing taxes
• Viewing adjustment documents

Modifying taxes

In the Sales Tax Entry window, if the Apply Tax and Apply Withholding checkboxes 
are marked, you can view the default taxes and withholdings for the transaction. 
You can modify these taxes and add new ones if required. The taxes and 
withholdings displayed here are applied by default when you post the transaction. 
If the check boxes are not marked, you can view the taxes and withholdings for the 
transaction in the Potential Sales Tax Entry window. Such taxes and withholdings 
are potential taxes. Potential taxes do not appear on the invoice, and can be applied 
to a document even after it has been posted. You can convert potential taxes to 
applied taxes by marking the relevant checkbox before posting the transaction.

The default status for these checkboxes depends on your settings in the Default Tax 
Setup - Sales window. Refer to Setting up the sales tax defaults on page 5 for more 
information. You can change the default settings at any time before you post the 
transaction.

The withholding taxes are identified by a minus sign, or as selected in the Negative Sign 
setup for the currency in the Currency Setup window (Microsoft Dynamics GP menu >> 
Tools >> Setup >> System >> Currency).
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To modify taxes:
1. Open the Sales Tax Entry window.

(Transactions >> Sales >> Transaction Entry >> Tax expansion button)
(Transactions >> Sales >> Sales Transaction Entry >> Tax expansion button)

The Type, Document No. and Pre-Tax Amount fields display the values from 
the Receivables Transaction Entry window.

2. Mark the Apply Taxes checkbox to view the default taxes for the transaction in 
the scrolling window. Unmark this checkbox to treat the taxes as potential taxes.

3. Mark the Apply Withholdings checkbox to view the default withholdings for 
the transaction in the scrolling window. Unmark this checkbox to treat the taxes 
as potential withholdings.

4. Enter or select a tax detail ID.

5. View or change the total sales, the total taxable sales, and the tax calculated on 
the sales.

6. Enter or select a posting account for the tax. The tax amount for the detail is 
posted to the account.

7. To delete a tax detail, select the row containing the detail to delete and choose 
Edit >> Delete Row. To delete all the tax distributions, choose Delete.

8. To distribute taxes to multiple accounts, change the default amount in the 
scrolling window and enter another tax detail and tax amount in the next 
available line.

9. Click the Apply Withholding expansion button to open the Potential 
Receivables Tax window where you can view the default potential taxes and 
withholdings. This button is available only if you have unmarked either the 
Apply Taxes or Apply Withholdings checkbox in the Receivables Tax Entry 
window.
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10. Choose the View icon to select whether to view all applied taxes, or only 
positive applied taxes, or only applied withholdings.

11. Choose OK to close the window.

Viewing potential taxes for Receivables Management 
transactions

Use the Potential Receivables Tax window to view the potential taxes or 
withholdings. This window is available only if the Apply Taxes or the Apply 
Withholdings checkbox in the Receivables Tax Entry window is unmarked.

To view potential taxes for Receivables Management 
transactions:
1. Open the Potential Receivables Tax window.

(Transactions >> Sales >> Transaction Entry >> Tax expansion button >> Apply 
Withholding expansion button)

The Type, Document No. and Pre-tax Amount fields display the values from the 
Receivables Transaction Entry window. The scrolling window displays the 
taxes and withholdings for the transaction that are payable at a future date.

2. Choose OK to close the window.

Viewing potential taxes for Sales Order Processing 
transactions

Use the Potential SOP Tax window to view the potential taxes or withholdings. This 
window is available only if the Apply Taxes or the Apply Withholdings checkbox in 
the Sales Tax Summary Entry window is unmarked.
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To view potential taxes for Sales Order Processing 
transactions:
1. Open the Potential SOP Tax window.

(Transactions >> Sales >> Sales Transaction Entry >> Select a Customer ID >> 
Tax expansion button >> Apply Withholding expansion button)

The Type, Document No. and Pre-tax Amount fields display the values from the 
Sales Transaction Entry window. The scrolling window displays the taxes and 
withholdings for the transaction that are payable at a future date.

2. Choose OK to close the window.

Using the Sales Tax wizard

Use the Sales Tax Wizard to modify taxes and withholdings. You can add the 
potential taxes and apply them to the documents. These potential taxes will be 
transferred to the General Ledger tax account. You can also generate the credit notes 
and debit notes for the taxes that are edited.

To use the Sales Tax wizard:
1. Open the Sales Tax wizard.

(Transactions >> Sales >> Tax wizard)
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2. In the Select By field, select whether to edit taxes based on the Customer ID, 
Customer Name, or Class ID.

3. Select All or enter the range for the selected criterion in the From and Until 
fields.

4. Enter the date to generate the debit and credit notes for the taxes that are edited.

5. Enter or select the currency in the Currency field.

6. Enter or select a batch in the Batch ID field.

7. Select whether to edit positive taxes or withholdings in the Modify Taxes group.

8. Choose Next to open the Sales Tax wizard - Step 2 window. 

The Date, Currency, and Batch ID fields display the values you selected in the 
first window of the Sales Tax wizard. The scrolling window displays the details 
for all the documents that fall within the selected criteria.

9. Choose the Apply to Documents expansion button to open the Edit Taxes 
window or the Generated Documents window. You can edit the taxes for a 
selected document in the Edit Taxes window before applying. The Generated 
Documents window displays the debit or credit notes generated for edited 
taxes. Refer to Editing taxes on page 12 and Viewing adjustment documents on 
page 13 for more information.

10. Choose Mark All to select all the documents that are displayed in the scrolling 
window for applying.

11. Choose Unmark All to clear the selection for all the documents that are 
displayed in the scrolling window.

12. Choose Apply to apply the taxes to the documents marked in the scrolling 
window.

13. Choose Preview to view a report of the edited tax amounts before applying 
them.
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14. Choose Auto-Apply to apply the potential taxes to as many documents as the 
tax amount being applied permits.

15. Choose Redisplay to refresh the scrolling window with any information entered 
since you last saved.

16. Select a document and choose Cancel to revert any changes you made to the tax 
information for the document. You cannot revert the changes once you have 
applied the document.

Editing taxes

Use the Edit Taxes window to view the applied and potential taxes and 
withholdings for a selected document. You can void an applied tax or add a new tax 
detail ID to the document in this window. You can edit the tax amount for the taxes 
that are not yet applied. You can apply the potential taxes displayed in this window 
to the selected document in the Sales Tax Wizard - Step 2 window.

To edit taxes:
1. Open the Edit Taxes window.

(Transactions >> Sales >> Tax Wizard >> Sales Tax wizard - Step 2 >> Apply to 
Document expansion button >> Select Edit Taxes)

The Document Number, Type, Client ID and Name fields display the values 
from the Receivables Transaction Entry window. The Canceled Tax scrolling 
window displays the tax details and tax amount for applied taxes or 
withholdings.

2. In the Canceled Tax scrolling window, mark the Void checkbox for an applied 
tax to void it.

You cannot change the tax amount for an applied tax in the Canceled Tax scrolling 
window. To do this, you must first void the tax. You can then re-add the tax detail ID in 
the Added Tax scrolling window, and enter the required amount.
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3. Choose Default to display the potential taxes or withholdings for the document 
in the Added Tax scrolling window. You can change the tax amount for the tax 
detail IDs displayed and add new tax details IDs if required in this scrolling 
window.

4. Choose OK to save the changes and close the window.

Viewing adjustment documents

Adjustment documents such as the debit notes and credit notes are generated when 
you cancel or add taxes and withholdings. These debit notes and credit notes are 
generated after applying the taxes to the documents displayed in the scrolling 
window in the Sales Tax wizard - Step 2. A debit note is generated when you add a 
tax or cancel a withholding. A credit note is generated when you cancel a tax or add 
a withholding in the Edit Taxes window. Refer to Editing taxes on page 12 for more 
information.

To view adjustment documents:
1. Open the Generated Documents window.

(Transactions >> Sales >> Tax Wizard >> Sales Tax wizard - Step 2 >> Apply to 
Document expansion button >> Select Generated Documents)

The Type and Voucher fields display the type of document and the voucher 
number.

2. In the scrolling window, the Type column displays the type of adjustment 
document generated, whether debit note or credit note. The Voucher column 
displays the voucher number for the adjustment document generated.

3. Choose OK to close the window.
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Chapter 3: Inquiries and reports
You can use inquiries to view the information you have entered into the system. You 
can analyze the transaction information, and display the information on the 
computer screen.

Tax Administration Sales reports are available in the report list. You can select a 
report in the report list and add it to My Reports for easy access. Refer to the 
Microsoft Dynamics GP documentation for more information.

This information is divided into the following sections:

• Viewing the applied taxes
• Viewing potential taxes for posted receivables transactions
• Viewing potential taxes for posted Sales Order Processing transactions
• Viewing the edited taxes
• Printing the sales tax reports

Viewing the applied taxes

Use the Receivables Tax Inquiry windows to view the tax information for posted 
sales transactions. You can also view the default tax settings for the debit notes and 
credit notes that are generated for the applied taxes and withholdings. Refer to the 
Receivables Management documentation for more information on viewing 
transaction information.

Viewing potential taxes for posted receivables 
transactions

Use the Potential Receivables Tax Inquiry window to view the potential taxes for 
posted sales transactions.
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To view the potential taxes for posted receivables 
transactions:
1. Open the Potential Receivables Tax Inquiry window.

(Inquiry >> Sales >> Transaction by Customer/ Transaction by Document >> 
Select a Customer ID or Document Number >> Select a document in the 
scrolling window >> Click the Document Number link >> Tax expansion 
button >> Apply Withholding expansion button)

The Type, Document No. and Pre-tax Amount fields display the values from the 
Receivables Tax Inquiry window. The scrolling window displays the potential 
taxes for the document you have selected in the Sales Transaction Inquiry - 
Customer/Receivables Transaction Inquiry - Document windows.

2. Choose the View icon to view the potential taxes for positive taxes or 
withholdings.

3. Choose OK to close the window.

Viewing potential taxes for posted Sales Order 
Processing transactions

Use the Potential SOP Tax Inquiry window to view the potential taxes for posted 
Sales Order Processing transactions.
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To view the potential taxes for posted Sales Order 
Processing transactions:
1. Open the Potential SOP Tax Inquiry window.

(Inquiry >> Sales >> Sales Documents >> Select a document in the scrolling 
window >> Click the Document Number link >> Tax expansion button >> 
Apply Withholding expansion button)
(Inquiry >> Sales >> Transaction by Customer / Transaction by Document >> 
Select a Customer ID or Document Number >> Select a document in the 
scrolling window >> Click the Document Number link >> Tax expansion 
button >> Apply Withholding expansion button)

The Type, Document No. and Pre-tax Amount fields display the values from the 
Sales Transaction Inquiry Zoom window. The scrolling window displays the 
potential taxes for the document you have selected in the Sales Transaction 
Inquiry - Customer/Receivables Transaction Inquiry - Document, or Sales 
Order Processing Document Inquiry windows.

2. Choose the View icon to view the potential taxes for positive taxes or 
withholdings.

3. Choose OK to close the window.

Viewing the edited taxes

Use the Added/Canceled Receivables Tax Inquiry window to view the taxes that 
you edited or voided in the Edit Taxes window. Refer to Editing taxes on page 12 for 
more information.
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To view the edited taxes:
1. Open the Added/Canceled Receivables Tax Inquiry window.

(Inquiry >> Sales >> Transaction by Customer / Transaction by Document >> 
Select a document in the scrolling window >> Click the Document Number 
link  >> Apply button >> Net Change expansion button)

The Document Number and Type fields display the values from the Receivables 
Transaction Inquiry Zoom window. The Added Tax scrolling window displays 
the tax details and tax amount for the taxes you have edited and applied.

2. The Canceled Tax scrolling window displays the taxes that you have voided in 
the Edit Taxes window.

3. Choose OK to close the window.
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Printing the sales tax reports

You can print the Historical Aged Trial Balance Report to view the taxes and 
withholdings for sales transactions.

To print the sales tax reports:
1. Open the Receivables Trial Balance Reports window.

(Reports >> Sales >> Trial Balance)

2. In the Reports field, select Historical Aged Trial Balance. Refer to the 
Receivables Management documentation for more information.

3. Choose Print to print the detailed and summary sales tax reports.
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